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1 Getting Started

ClickBook is so easy to use.  Just choose File / Print from any program and
choose the "ClickBook Printer" when printing.

1.1 What Does ClickBook Do?

ClickBook prints files, documents, graphics, spreadsheets, or web pages from any Windows
application:

· As Double or Single sided.
· As Books of any size.
· As brochures or leaflets.
· As greeting cards.
· As CD Jewel Cases.
· As Day Planners.
· As business cards.
· As Avery Labels.
· As Banners of any size (Windows XP, 2000, 2003 only)
· As Posters of any size (Windows XP, 2000, 2003 only)
· As PDF files

Top Uses for ClickBook:

· Print double-sided without a duplexing printer.
· Print organization charts or schedules on large posters
· Fit a large spreadsheet on one page with several pages on each sheet of paper.
· Combine documents, web pages, and other files into a single print job.
· Print an address book to fit in your day planner, purse, wallet, etc.
· Create a list of songs and artists and print a booklet that will fit in a CD Jewel Case.
· Design Greeting Cards or print electronic greeting cards received.
· Print goals, and objectives in large formats for posting on the walls
· Gather a collection of recipes and print them as a wallet booklet.
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· Sales & Marketing Managers use ClickBook to print media, product information, press kits, news,
etc.

· Posters for Schedules, Plans, Birthday, Calendars, Pictures, Charity Events, Bulletin Boards,
Advertisements (Windows XP, 2000, 2003 only)

· Educators print handouts, assignments, lessons, ebooks, posters, etc.
· Combine your documents into one convenient PDF file

About printing books
Printing books requires a special arrangement of the pages.  ClickBook takes care of this, giving you
instructions each step of the way so that the back sides are printed correctly relative to the front sides,
and so that after you cut and assemble the book, the pages come out in the right order.

ClickBook has over 170 layouts to choose from, and you can create your own so the variety is endless.
The layouts that come with ClickBook enable you to print:

· Sizes from poster size down to credit card size.
· Suited for folding and stapling or for cutting and binding by any method.
· Two "binding orientations": for binding in the left margin (and turning pages in the standard way) or

in the top margin (and flipping pages up).
· Pages of book oriented either as portrait or as landscape.

1.2 How Does ClickBook Work?

ClickBook takes what you print from your application – exactly what would print if you were not using
ClickBook – and shrinks and rearranges the pages to fit the layout you choose.

ClickBook does not change any formatting done by the application program.  Each page is preserved
exactly as the application sent it, including margins, page numbering, headers/footers, and all
paragraph formatting – everything.

ClickBook formats your document in some or all of the following ways, depending on the printout layout
you select and any modifications you may make to it:

· Shrinking to fit several pages on one sheet of paper.
· Expanding it to "poster" sized and printing it on multiple pages. (Windows XP, 2000, 2003 only)
· Arranging the mini-pages so that they come out in numerical order after cutting and assembling.
· Printing double sided.
· Adding ClickBook margins.
· Adding extra space for binding.
· Adding Headers, Footers or Watermarks.

1.3 What's New In ClickBook 9.0?

Below is a list of the new features we have added to ClickBook 9.0.

· PDF - Make PDF files of your booklets
· Direct printer properties control for extended printer features.
· Pages - Add, remove and rearrange pages in the booklet before printing
· New layouts for day planners (various brands)
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· More printer profiles for easier setup
· Improved Zooming in the preview

1.4 Printing With ClickBook

The ClickBook printing process typically begins in your application program.  You prepare your
document as usual, and then you give the print command.  Set options as you wish in the print dialog
box, choose the ClickBook Printer, and click OK.  This launches ClickBook where you'll select a layout,
optionally change other settings, and hit ClickBook's Print button to send the print job to the printer.

ClickBook gives you instructions at each step of the way, including how to re-insert the paper to print
the second sides.  Following the instructions ensures that the backsides are printed correctly relative to
the front sides, and that after you cut and assemble the booklet, the pages are in the right order.

1.5 Printing Your First Booklet

To Print your first ClickBook Booklet follow these steps.

1. Open the document in its application program.
2. Print the document to the ClickBook Printer (Usually File->Print)
3. When ClickBook pops up, select a layout.
4. Click ClickBook's Print button.  (Skip to step 8 now if you're using a duplexing printer.)
5. When the first-side print job is completely finished, remove the printout stack carefully.  Treat the

sheets as though they're glued together – do not rearrange them.
6. Without lifting it off the stack, read the instruction sheet (with the big arrow).  It tells you whether to

put the paper in face up or face down, and which end of the paper goes in first.  Following the
instructions, reinsert the printout stack into the paper tray.

7. In ClickBook, click the Print Second Side button.
8. When the second-side print job is completed, retrieve the printout and remove the instruction

sheet.
9. Assemble the booklet, according to its layout.

1.6 Preparing A Document In Its Application Program

Prepare your document as you usually do, but keep in mind that ClickBook will usually shrink the
pages.  (ClickBook will scale them down unless the layout is full-sized or uses the No scaling setting.)

If you plan to use a layout that shrinks the pages considerably, enlarge your fonts accordingly.  They
should be large enough to be readable at the mini-page size.  Normally, no other special preparation is
needed for printing with ClickBook.  But in some cases you may want to adjust the document in the
following ways:

· Use a different font that may scale better.  We recommend True Type fonts, which are fully
scalable.

· When printing a multi-document booklet, modify or add headers/footers that are appropriate for
the booklet.  In particular, you may want to adjust page numbering to be continuous throughout the
whole booklet.  See… Headers/footers for a multi-document booklet.

· Turn off right justification of text if the right edge came out uneven on the printout.
· Adjust the margins (or set margins in ClickBook).
· Select No scaling and then set everything at exactly the size you want it to print.  This includes

setting fonts at desired sizes, and setting the page size to be equal to the mini-page size in the
intended ClickBook layout ClickBook usually assures that the pages fit the mini-pages, but with
scaling off, this is your responsibility.
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1.7 Saving A Booklet As a File

To save a print job as a .cb file just follow these steps:

1. Press the Save button   on the tool bar.

Or

Click File on the menu options then click on Save or Save As.

2. The Save As dialog appears.  From the Save in: drop down menu choose the location on your
computer where you want to store the .cb file.

3. In the File name: field type in the name you wish to call the .cb file.
4. Press Save. Note: before saving, make sure you've deleted or undeleted documents as desired.

Any documents marked as deleted when you save will not be included in the ClickBook .cb file.
Tip: If you want to print similar booklets containing different subsets of a group of documents, save
the whole group as a .cb file.  Then, whenever you want to print, open the file and temporarily
delete undesired documents.

Note: The .cb file contains the contents of the documents, not just the file names.  So, if you edit any of
the documents after saving the .cb file, these changes are not reflected in the .cb file.

2 Installation

The installation setup program for Windows is called ClickBook9Setup.exe. You must run the setup
program to install ClickBook to your hard disk.  So that you know what to expect, here's a summary of
what the setup program does:

· Copies the ClickBook System files to your hard disk.
· Creates a ClickBook program group and icons.
· Once it's finished installing ClickBook launches the Add Printer dialog where you'll setup a

ClickBook Printer on your system. Then ClickBook's Printer Setup dialog box will open and you will
set up the printer(s) you want to use with ClickBook.  You can choose from the Easy Printer Setup
Wizard or the Custom Printer Setup Wizard.  If you select the Easy Printer Setup Wizard, and
ClickBook tells you that it does not recognize your printer you need to run Custom Printer Setup
Wizard.  See "Setting Up an Unrecognized Printer", on the adjacent page.

· At the end of the installation process ClickBook presents you with the option to view the
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README.RTF.  We recommend looking this document over because it contains more information
about ClickBook, and the changes that have taken place from previous versions. ClickBook's
online help file provides you with detailed instructions to print the README.RTF as a booklet.

· When you first start the ClickBook program the InstantX registration dialog box will appear.  To
fully register your copy of ClickBook please fill out the form, and send it electronically, or print the
form and mail it back to Blue Squirrel.  If you don't register ClickBook the InstantX dialog box will
pop up each time you run the program.  Once you have registered, you'll see your License Key
code in the About ClickBook box.

· Places a customized Print Using ClickBook command into a menu of your application program.
This feature is available for several leading application programs.

2.1 Run The Setup Program

To Run the Setup Program:

1. If you have ClickBook on a CD insert the CD into an appropriate drive. Or if your copy of
ClickBook is a zipped (*.ZIP) or self-extracting executable (*.EXE) file, copy it into an empty folder.
Double-click or use a zip manager to expand the file.  You can obtain a copy of the self-extracting
executable from our Web site, http://www.bluesquirrel.com/download/ClickBook9Setup.exe.

2. If you have the Blue Squirrel Sampler CD, its AutoStart function will load the CD and present you
with an opening screen.  To start the installation process, click on the picture of the ClickBook box.

3. If you have the ClickBook program in another format, click the Windows Start button, choose
Settings, and the Control Panel.  Double-click Add/Remove Programs.  On the Install/Uninstall
page, choose Install, and then Next.  Use the Browse button to navigate to the folder into which
you copied or expanded your ClickBook files and click Finish.

4. Follow the prompts on the next screens of the Install Wizard.

When the Setup program is completed, you will need to setup a ClickBook Printer, setup your
printer(s), enter registration information, and then you're ready to print with ClickBook.

System Requirements

· Pentium 100 or faster machine
· 64+ MB of RAM
· 14 MB of free disk space
· Laser or InkJet printer

2.2 Automatic Printer Setup

First you will setup a single "ClickBook Printer" on your system, and then you'll be required to setup
your printer(s) in the ClickBook software.

To automatically detect and install the ClickBook Printer follow these steps:

1. When you are finished installing ClickBook 9.0, the Add Printer dialog will add a "ClickBook
Printer" to your system. If this dialog does not appear go to your Windows Start button, select
Programs, Blue Squirrel and ClickBook. If this is the first time you are opening ClickBook you will
need to fill in your registration information, close the Tip of the day dialog and the Add Printer
dialog will appear.

2. In the Add Printer dialog press OK.  Note: the Add Driver dialog will only pop up if you have
Windows NT. Press OK to continue.

3. The Add Driver dialog will appear, press OK. Now you have setup a "ClickBook Printer", which will
appear in most of your application programs on your computer.

http://www.bluesquirrel.com/download/ClickBook9Setup.exe
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Now you will need to setup your printer(s) in the ClickBook software.  Go to Easy Printer Setup to do
this.

2.3 Printer Setup

Every printer that you use with ClickBook must be set up.  This tells ClickBook how your printer
handles paper.  This is necessary to do double-sided print jobs, and so ClickBook can print in the
right order.

If you see the  (icon) next to your printer it means the printer has already been set up with
ClickBook.

There are three ways to set up a printer:

Easy Printer Setup - This option tries to determine your printer type from the name and match it
against a database of printers that ClickBook is aware of.  In many cases the correct choice will be
highlighted and you just hit OK.  If you can't find an exact match, then you can usually choose a
printer from the same "family."  For example, an HP 1115 would be the same as an HP 1100 printer.
If your printer is not listed, it does NOT mean that ClickBook won't work with your printer, it simply
means you'll need to use the Custom Printer Setup to set up your printer.

Custom Printer Setup - This option takes you through a step-by-step process where you print some
pages, re-insert the paper and then identify the images.  Using the information that you provide the
program sets up your printer for use with ClickBook.

Manual Printer Setup - This option lets you answer some questions to provide information to
ClickBook about your printer and how it handles paper.  There is also a button that will take you to a
website where other ClickBook users have provided the configuration that worked for their printer.

Properties... - Set the unique properties of each printer.  Does it duplex (print on both sides
automatically)?
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2.4 Easy Printer Setup

Once you have installed a ClickBook Printer you will be required to setup your printer(s) in the
ClickBook software.  Note: You don't need another driver.  A Windows printer driver for the printer, and
ClickBook, are all you need.

Follow these steps to use ClickBook's Easy Printer Setup:

1. First, make sure that the printer is installed in your Windows system.
2. Open ClickBook Printer Setup, which is found in the File menu, or click the Windows Start button,

go to Programs, Blue Squirrel, and click on ClickBook Printer Setup.
3. Choose your printer model from the Printer to Set Up drop down list.
4. Click Easy Printer Setup.
5. Make sure the correct printer is highlighted, and click OK. If your printer is not on the list, click

Cancel.  Then run Custom Printer Setup.
6. Depending on your printer model, ClickBook may present you with another screen asking you if

your printer can duplex. Answer Yes, if your printer prints double-sided without user intervention.
Answer No, if your printer only prints single-sided.

7. Please repeat steps 1 through 6 to setup a second, third or fourth printer.

Note: For most programs, you can substitute one printer model for another similar one.  However,
because ClickBook prints double-sided, it needs very specific information about the actual printer
you're using.  If your printer model is not in ClickBook's list, it's best to use the
Custom Printer Setup Wizard.

2.5 Custom Printer Setup

If you are unable to setup your printer with ClickBook's Easy Printer Setup, you can elect to use the
Custom Printer Setup Wizard.

Here's a summary of what Custom Printer Setup does: First, the program prints two (single-sided)
pages and asks you a question about how they printed.  Next, you're instructed on how to reinsert the
printout and begin printing the second pass.  Afterward, you're again asked to report on what the
printout looks like.
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To use the Custom Printer Setup Wizard follow these steps:

1. Make sure the printer you wish to setup is ready to print (turned on, online, paper loaded, etc.)
2. Open ClickBook Printer Setup, which is found in the File menu, or click the Windows Start button,

go to Programs, Blue Squirrel, and click on ClickBook Printer Setup.
3. Choose your printer model from the Printer list. Doing so, will enable Custom Printer Setup radio

button.
4. Click the Custom Printer Setup radio button.  When you're ready to start press the Setup... button.

Follow the instructions presented on the screen.
5. Please repeat steps 1 through 4 to setup a second, third or fourth printer.

2.6 Setting Up A Duplexing Printer For Use With ClickBook

Using a duplexing printer (one that automatically handles double-sided printing) with ClickBook is easy.
ClickBook sends out only one print job for both the front and back sides, so you skip the step of
reinserting the printout stack and then printing the second print job.
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Follow these steps to prepare your duplexing printer:

1. First, make sure that the printer is installed in your Windows system
2. While in standalone mode, go to File on the menu bar and click on ClickBook Printer Setup.
3. Choose your printer model from the Printer list.  Please ensure that you have already setup your

printer to work with ClickBook. If you have not, please follow the Easy Printer Setup instructions to
do so, before moving onto step 4.

4. Click the Properties... button
5. Choose Automatic duplexing.
6. Select the printer style.  There are 4 different styles of duplexing printers.  They are:

· Style 1  - The most common duplex style.  This is the default setting.  Duplexing is based on the
orientation of paper where short edge represents the horizontal edge.

· Style 2  - The reverse of "Style 1".  Commonly used by PostScript drivers.  Duplexing is based
on the orientation of the paper where long edge represents the horizontal edge.

· Style 3  - This style is independent of the orientation of the paper.  Duplexing is based on the
horizontal axis representing the horizontal edge.  This is the way the Windows API expects
printer drivers to duplex.

· Style 4  - This style is the reverse of "Style 3".  It is also independent of the paper.  Duplexing is
based on the horizontal axis representing the vertical edge.

7. Click OK.

Note: If you are printing a booklet with ClickBook, and you only use a duplexing printer, ignore any Help
that concerns reinserting the paper before printing the second side.

2.7 Uninstalling ClickBook

To uninstall ClickBook from your computer please follow these steps:

1. Click the Microsoft Windows Start button on and select Settings, Control Panel from the Start
Menu.

2. Double click the Add/Remove Programs Icon, and the Windows Add/Remove Programs
Properties dialog box appears.

3. Select Blue Squirrel ClickBook in the list of software available, and click the Add/Remove button.
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4. The following dialog confirms your request to uninstall.
5. If you are certain you want to uninstall ClickBook click the Yes button.

3 Tour ClickBook
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3.1 ClickBook's Main Screen

ClickBook's main window is divided into five separate parts: Menu bar , Toolbar , Print Jobs, Status
bar, and Print Preview.

· The Menu Bar offers access to commands organized into menus.
· The ToolBar offers one-click access to the most commonly used commands.
· Print Jobs allows you to print all or a range of pages, determine how many copies to print, which

printer will receive the print job, which applications are going to be printed, and allows you to
remove unwanted applications.

· Print Preview provides an idea of what the document will look like when it is printed for the chosen
layout.

· Status Bar displays the total amount of pages that will be sent to the printer, how much paper you
will save, and if the Ink Saver feature is enabled.

3.2 Toolbar

The ClickBook Toolbar offers one click access to frequently used commands.
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 The Open File dialog box appears where you can open an existing ClickBook (.cb) file.

 The Save As dialog box appears and allows you to save the current project as a ClickBook
(.cb) file.

 Sends the current project to the printer(s).

 Create a PDF file.

 The Options dialog box appears where you can change print settings, program settings, and
paper/border settings, and header/footer/watermark settings.

 The Poster Wizard lets you create posters of any size or shape. (Windows XP, 2000, 2003
only)

 Will insert a blank page in the Print Jobs.

 This option launches the ClickBook Help File. Use this option to learn how to use ClickBook,
or to answer specific questions on ClickBook functions.

 Displays a short explanation for the selected Layout at the bottom of the Print Preview
Window.

 Launches your default Internet browser and opens the Blue Squirrel Home page.

 Displays version and copyright information about ClickBook.

3.3 Print Jobs

Print Jobs displays information pertaining to the files received from their corresponding applications.  It
also allows you to print all or a range of pages, determine how many copies to print, and which printer
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will receive the print job.

· Lists the title and amount of pages received for each file.
· Select a file and use your mouse to click-and-drag it to rearrange the print order.
· Uncheck items to remove files from the project.
· Print Status displays how many pages ClickBook received from the application program.
· Printer drop down menu lists the printers you have setup to work with ClickBook, and the current

chosen printer will receive the print job.
· Print Sends the current files that are listed in the Print Jobs to the printer.

· Page Range can be used to print specific pages or a range of pages.   The page
numbers are determined by the red numbers on the Print Preview Window. For example, [1-
5,9,15] will print pages 1 through 5, page 9, and page 15. ClickBook will skip pages 7,8, and 10
through 14.

· # of Copies lets you enter the amount of copies to print.
· Choosing Jobs lets you re-arrange print jobs in your booklet.  Choosing Pages lets you drag and

drop pages and re-order them in any order.

3.4 Print Preview

The Print Preview screen displays the following:
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· Shows you how the selected layout for the Print Jobs will look once it is sent to the printer.
· Scroll arrows offer front-side and backside page navigation.
· Drop down menus allow you to select various categories, and Layouts.
· Sheet Selection allows you to print just the front, back or both pages of a document, as well as,

determine which pages to begin and end printing.
· Brief description pertaining to the selected layout.

3.5 Status Bar

The Status bar provides information pertaining to the current Print Jobs.

· Paper Saving Meter displays how much paper you will save with the current printout, and how
much paper you have saved overall by using ClickBook.

· If you are printing a poster, the status bar changes to give you information about the poster you
are printing.

3.6 Ways To Start ClickBook

Here are various ways to start ClickBookin either standalone mode or printing mode.  (These aren't the
only ways, but they should be sufficient.)

Standalone mode
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· Open ClickBook from the Microsoft Window's Start menu, select Programs, Blue Squirrel, and
ClickBook.

Printing mode

· Open your document in its application program by using the document's filename from the start
menu, the Explorer, or the My Computer window (or in any other way).  Then print the document to
ClickBook.

· From the Explorer or My Computer, drag the document's icon to a ClickBook Printer shortcut on
the desktop.

· If the ClickBook Printer does not have a shortcut on the desktop, open the Printer's window from
the Control Panel or My Computer.  Then, from the Explorer or My Computer, drag the documents
icon to the ClickBook printer icon.

· Open a .cb file from the Start menu, the Explorer or My Computer,  This starts ClickBook and
loads the booklet in preparation for printing.

· Open ClickBook in standalone mode.  Then open a .cb file from the File menu and click Open.

4 Printing with ClickBook
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4.1 Quick Start Wizard

The Quick Start Wizard gives you a choice for what type of document you'd like to print.  If you don't
want to see the wizard every time, uncheck the option for "Show this wizard on StartUp."
The Quick Start Wizard will take you to the most popular layout for a category.  If the layout selected is
not what you want, then choose a different layout from the category.

4.2 Sample Documents

ClickBook comes with sample documents for each layout.  Most of the documents are Microsoft Word
documents that can be used as a starting point when creating booklets, tri-folds, french folds, labels,
etc.

The reason for including sample documents is that some of the layouts require specific margins, or
number of pages to work properly with the layout.  The sample documents will be pre-set with those
pages, margins and other page settings.

To use a sample document, simply choose the layout you wish to use, then hit the Samples button on
the toolbar, or choose Help->"Sample Documents..." and then hit "Use this layout with its sample
document"

The sample document will be loaded up in Word or other word processor and you can modify the
contents to meet your needs.

4.3 Printing A Multi-document Booklet

Summary: To print several documents as a single booklet, just wait to click ClickBook's Print button
until after you have sent all the documents to ClickBook.

When you send a document to ClickBook, the software program opens and begins receiving and
processing the document.  If you send a second document, as long as you have not yet clicked
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ClickBook's Print button, the second document becomes part of the same booklet.  You can send a
third document, and so on.  The documents can come from different applications, but must be sent to
the same printer.

Note: If you want to print from many applications, you can close each application as soon as it has
finished printing (sending the pages) to ClickBook.  This may help if you find that you don't have
enough memory, or that your computer is operating slowly.

Once you have sent all of the desired documents to ClickBook, you can adjust settings – for example,
select a different layout.  Notice that all of your desired documents in the Print Jobs box.  If you want to
cancel any of your documents from printing just click on the check mark in the box next to the
documents name.  If you want the documents to print in a different order just left click and hold on the
document you want to move and slide to the desired order of the print job.

Finally, once you have verified the contents of the booklet and you are ready to print, click Print.

Important: The defining document
The first document you send to ClickBook for a given booklet is the defining document.  ClickBook
uses the following settings from the defining document for all the documents you print together as one
booklet.

· Page settings (set these in your application or through Windows printer setup):
· Page orientation (portrait/landscape)
· Page width and height
· Layout (set in ClickBook)

Tip: To make sure the settings match, or to find out what the discrepancies are, you can view a list
comparing any document with the defining document.  Just select that documents name (in the Print
Job box) and then right-click.

Ensure that you send all documents to the ClickBook printer.  Some application programs remember
the printer last used for each document.  If your application does this, check the printer for each
document before giving the print command.

Printing multiple documents as separate booklets
If you wish to print multiple documents as separate booklets one immediately after another, simply
click ClickBook's print button for one document before you send the next document to ClickBook.  Or ,
if you send documents to different printers, each printer's set of documents will be printed as a
separate booklet.
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4.4 Poster Wizard

The Poster Wizard is a quick and easy way to make a poster or banner (Windows XP, 2000, 2003
only).  You choose the size of your poster or banner, and ClickBook will automatically determine the
pages needed to create it.

If you choose Maintain document aspect ration (shape), you can change Width OR Height and the
other one will be calculated for you to keep the poster the same shape as the source document.  If
you haven't printed a document to ClickBook yet, it will keep the same shape as your default paper
setting.  Using this option will make it so it does not matter whether you choose Stretch to fit, Size to
fit (1:1) or Crop/Banner.

Stretch to fit will stretch your source document to fit the poster size.  Photos may not look right if
stretched too much.  Stretched letters usually look fine unless stretched too much.

Size to fit (1:1) - will make your document fit and not be stretched.  ClickBook will center the
document if you have made the poster size too wide or too tall.  This is a good option if you have
photographs.

Crop /Banner (1:1) - will make your document fit in one direction only, and crop off the rest if the
poster/banner is not the same shape as the source document.

Save As... allows you to save your custom poster size as a new layout.

A banner is a just a really wide, or really tall poster.  If you want to do a banner, you should choose
Crop/Banner and only the top part of your document will be printed.  In your application (like
Microsoft Word), you would put your words like "Congratulations to Johnny on making straight A's" at
the top of the Word document.  The bottom part of the Word document will be "Cropped" off and not
printed on the banner.
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See information on the assembly of your poster.

More options for your custom poster are available under Layouts->Modify Layout...

4.5 Layout Wizard

The Layout Wizard is a simplified process to change settings for a particular Layout.

To use the Layout Wizard proceed as follows:

1. Open the Layout Wizard.  From the Menu Bar select layouts and click on the Layout Wizard.
3. Make desired changes and click Next to proceed through the steps.
4. If, at any time, you want to quit the Layout Wizard click Cancel.

4.6 Modify Layout

The Modify Layout dialog box allows the user to make permanent changes to any layout format.  It also
allows the user to save their changes as a new layout by selecting Save As or to save their changes
over an existing layout by clicking done.

To access the Modify Layout dialog go to Layouts on the menu bar, and select Modify Layouts.
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· Booklet Style:
· Booklet Type - Select a booklet style such as Cut book, Folded book, French fold, Planner

pages, Poster, Tiled, and Tri-fold.
· Anti-Shingle -  In large folded booklets with more than 10 sheets of paper the edges start to

creep out in the center until the edge looks like a V.  We call this shingling.  ClickBook can move
the page towards the center so you can cut off excess paper without cutting into printed text.

· Mini-pgs. on Sheet - Select how many pages to put on a single sheet of paper.
· Sheet Orientation -  Select if you want the sheet to print in Portrait or Landscape Orientation.

· Binding
· Printer Paper Size - Select the size of paper you want to use.  This will override the default

setting that is under Tools->Options.
· Binding Edge - Choose how you want the binding edge.
· Print Sides - Select to print on one side or both sides of paper.

· Sub Booklets
· Repeat - The effect of Repeat depends on the current Layout.  Repeat can be used to print

more copies when there aren't enough mini-pages to fill the sheet.   Repeat can also be used,
alternatively, to avoid the step of assembling multiple booklets.

· Sub-Booklets - Rather than folding a whole booklet together, you may wish to print and fold
sub-booklets separately, and then bind them together.  Mark the check box to activate sub-
booklet printing.  Then set Pages-per to the number of pages you want each sub-booklet to
contain.

· Scaling
· Absolute Dimensions - ClickBook sets the Mini-page dimensions to fill a sheet of paper. You

can set the dimensions by turning on Absolute Dimensions.
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· Width - Specify the width to match a custom page size.
· Height - Specify the height to match a custom page size.
· Scaling - Choose the type of scaling to use, either One to One, No Scaling, or Stretch to fit.

· Margins
· Paper Margins - Allows you to change the margins for a sheet of paper.
· Mini-Page Margins - Allows you to change the mini-page margins for the current Layout.

· Save As... - Opens the Save As dialog box to save the layout with a new name.
· Done - Saves any changes made to the current Layout.
· Abandon Changes - Reverts to the layout's previous settings.
· Cancel - Closes the Modify Layouts dialog.

If you set the Booklet Type to Poster (Windows XP, 2000, 2003 only), you get other options:

· Paper Orientation - This lets you choose the orientation of the pages in the poster.
· Pages on Poster - This specifies how many pages will be printed per poster.  Across specifies the

number of pages going horizontally, and Down specifies the number of pages going vertically.
· Poster Margins - The top and left margins specify how far over the poster will begin printing from

the upper-left corner of the first piece of paper.  In most cases it makes sense to leave these at 0,
unless you are missing part of your poster because of the non-printable area of your printer.

· Poster Cropping - This will stretch your document to fit the poster in one direction and crop off
the other dimension if the document does not fit exactly.

· Scaling (Width/Height) - This is the total width and height of the poster after assembly.
· Overlap - This specifies how much overlap in each poster page.  The pages intentionally overlap

because most printers cannot print to the edge of the paper so there would be white gaps on the
poster.  You should trim off the white non-printable area before taping the poster together.

4.7 Assemble a Booklet

To turn on the Assembly Instructions:

1. Click the Options button   on the toolbar.  This will bring up the Options dialog box.
2. Choose the Print Settings tab and click in the box next to Print assembly instructions.
3. Click OK.
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4.8 Cutting And Assembling a Booklet

The cut marks on the printout are guidelines that show between which mini-pages to cut.  Their
position is accurate to about 1/16", which is not high precision for very small mini-pages.  Use your eye
or measure, in order to cut precisely halfway between mini-pages.

The marks themselves tell you the order of the cuts.  The solid line indicates the first cut, the line
composed of two dashes indicates the second, the line composed of three dashes indicates the third,
and so on.

The instructions below, or those printed with the printout, include the important information about how
to re-stack the cut sheets after each cut.  They give the general rules for cutting and assembling any
book of any layout.
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1. If the mini-pages do not fill the sheet (that is, if you specified absolute mini-page dimensions), the
first step is to cut away the extra paper.  If there is no extra to cut away, skip to step 4.

2. Cut at the "one-dash" cut mark, which indicates a vertical cut to eliminate extra paper on the right.
Discard the extraneous strips.

3. Cut at the "two dash" cut mark, which indicates a horizontal cut to eliminate extra paper at the
bottom.  Discard the extraneous strips.

4. Make the leftmost vertical cut.  (Look for the next cut mark.  Depending on whether you did steps
1.a. and/or 1.b., this may be composed of one, two or three dashes.)

5. Now your printout is split into two stacks.  Place the one with page 1 on top of the other, aligning
the top left corners.

6. Make the leftmost remaining vertical cut, if any.
7. Again, place the page 1 stack on top of the other, with top left corners together.
8. Continue in the same way until all vertical cuts have been made.
9. Make the top horizontal cut.
10. Place the page 1 stack on top of the other, with top left corners together.
11. Make the topmost remaining horizontal cut if any.
12. Place the page 1 stack on top of the other, with the top left corners together.
13. Continue in the same way until all horizontal cuts have been made.
14. Be sure to fold and/or bind on the edge indicated by your choice of layout, namely binding on the

left for a Standard book, or on top for a Flip book.  For a folded booklet layout: Remove blank mini-
sheets, if any, from the middle.  Fold in half and staple.  For a cut book layout: Remove blank mini-
pages, if any from the end.  Then bind.

Cutting options:
  Paper Trimmer - See our paper trimmers at http://www.bluesquirrel.com/so/trimmer/

Binding options:
  Staple (also called a saddle stitch) - See our specialized staplers at

http://www.bluesquirrel.com/clickbook/staplers.asp

4.9 Assembling a Poster

ClickBook makes poster creation easy (Windows XP, 2000, 2003 only).

Steps:
1. Print your document to ClickBook
2. Use Poster Wizard to create a poster of any size.
3. Hit print from ClickBook to print to your printer.

Once you've printed your poster you will have a stack of paper.  ClickBook has been designed so that
you should be able to take the stack and lay the pages out from left-to-right and then top-to-bottom, the
same way that you read.

http://www.bluesquirrel.com/so/trimmer/
http://www.bluesquirrel.com/clickbook/staplers.asp
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We suggest that you trim off the excess white space.  The white space is because of the non-printable
area of most printers.  Once you trim off the white space, you can line up each page with its previous
page and tape it together.

Options for fastening the pages together include:
· Staples
· Tape
· Glue onto poster board
· Staple directly to a wall or bulletin board

Trimming Hints:
You do not have to trim every side of every page because you can overlap the pages.  The pages are
printed so that there is some overlap.  This overlap helps you line up the pages.  By default, there is a
one inch overlap for each poster page.  The non-printable area takes up some of that one inch overlap,
and should be trimmed off.  If you don't want any overlap, trim off exactly one inch from the left side of
each page (except the pages in the first column), and one inch from the top (except the pages on the
first row).

4.10 Creating a Banner

You can use ClickBook to create a banner of any size (Windows XP, 2000, 2003 only).  And you can
use your favorite program to make the banner.

Our example uses Microsoft Word, but you can also use WordPad which comes with Windows, or any
other Windows program.

The key to creating a banner in ClickBook is to make your text go all the way across the paper in your
source document.  The easiest way to do this is to increase the font size until you've gone across the
paper.   You should set the paper margins to 1/4 inch in Page Setup... in Microsoft Word to make sure
you go all the way across the paper.
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You can also make tall banners.  Have the text go down the left side of the page from top to bottom.

You are not limited to one line of text for your banners.  Just make sure the longest line goes all the
way across the page.  Also make sure you put your text at the very top of the page.

Steps:
1. Print your document to ClickBook
2. Choose the Poster Wizard
3. Choose Crop/Banner (1:1) from in the Poster Wizard
4. Choose how wide you want your banner, and how tall you want your banner

Tip: When choosing how wide and how high you want your banner, keep in mind the shape of your
banner.  In the example above, you might make it 6 feet long and 1 foot high to keep the right shape.
Or 12 ft x 24" also works.  But 12 ft x 15" is not the right shape and does not work.  See the examples
below.  The width will always fit.  You should adjust the height of the banner to make sure you don't
chop off the bottom of your text.

6 ft x 12"   (RIGHT)

12 ft x 24"   (RIGHT)

12 ft x 15"  (WRONG)

Tip: Center your text at the top of the page, and then increase the font until your text goes edge-to-
edge.

4.11 Making a PDF file

ClickBook can make PDF files.  Choose your layout, and hit the PDF button.  Name your PDF file and
choose Save.
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The Save dialog has an option PDF Security... which lets you set an owner password, a user password
and set limits on what users can do with the PDF file.
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4.12 Printing a PDF booklet

Printing a booklet from a PDF works best if you have a duplexing printer that prints automatically on
both sides.  In the printing options, set to "Flip on Short Edge"

5 Advanced Options



Advanced Options 31

© 2005 Blue Squirrel

5.1 Insert A Header

You can add a header to the top position of each mini page.  You can select a separate font, color and
size for each type.  We have also provided four buttons that will insert the print job name, date, time
and page number into the header.

Job – <job> inserts the name of the first job listed in the Print Job bar
Date – <date> inserts the current date the job was printed using this format "month dd, yyyy"
Time – <time> inserts the current time the job was printed using this format "hh:mm AM/PM"
Page –  <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be
scaled down by a factor of 4 when used on a mini-page that is 4 times smaller than a regular sheet of
paper.  This makes it easy to set up a header, footer, or watermark that can be used for different
booklet types as the text will be automatically sized for each booklet.

To place a Header on your current print job follow these steps:

1. Click the Options button on the toolbar.  This will bring up the Options dialog box.
2. Select the Headers tab.
3. In order to print a header a check must be placed next to the Print Headers field.  Note:  Header

can be permanently shut off by un-checking the "Print Headers" checkbox.
5. Type your message in the text field box and/or select any of the following buttons

· Job: places the title of the first print job listed in the Print Job window.
· Date: Places today's date.
· Time: Places the current time.
· Page: Places the page Numbers.



ClickBook Help File32

© 2005 Blue Squirrel

6. To change the look and feel of the Header click the Select Font button. The Font window will open
and from here the Font, Font Style, Size, Effects, Color, and Script can all be changed.  The
Sample window will demonstrate how the changes will appear.

7. The Text justification allows you to choose where the Header will be placed: right, left, or center.
Place a mark next to the desired position.

8. The Start printing Headers on page option allows you to choose which page the Headers will
begin.  Note:  This feature allows you to start the process of printing Headers on the mini-page of
your choice.  This is useful for when you have a cover page and you don't want the page number
to be printed on that page.  Please note that the page numbering will start on the page you
choose.  For example if you start on page 3 it will be numbered as 1, page 4 will be 2 and so on.

9. The Stop printing Headers on page option allows you to choose which page the Headers will end.
Note: The default setting of 0 will end the printing of Headers on the last page.

10. Click Apply Changes to view any modifications you have made to your headers.  The changes will
appear in the print preview window.  If the changes are acceptable Click OK. Headers will now be
placed on your print job.

Note: Headers are not printed on posters.

5.2 Insert A Footer

Adding a Footer will place a line of text in the bottom position of each mini-page.  You can select a
separate font, color and size for each type.  We have also provided 4 buttons that will insert the print
job name, date, time and page number into the footer.

· Job – <job> inserts the name of the first job listed in the Print Job bar
· Date – <date> inserts the current date the job was printed using this format "month dd, yyyy"
· Time – <time> inserts the current time the job was printed using this format "hh:mm AM/PM"
· Page –  <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be
scaled down by a factor of 4 when used on a mini-page that is 4 times smaller than a regular sheet of
paper.  This makes it easy to set up a header, footer, or watermark that can be used for different
booklet types as the text will be automatically sized for each booklet.
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To place a Footer on your current print job follow these steps:

1. Click on the Options button on the toolbar.  This will bring up the Options dialog box.
2. Select the Headers, Footers, and Watermarks tab.
3. In order to print a header a check must be placed next to the Print Headers, Footers,  &

Watermarks field.  Note:  Header, Footers, and Watermarks can be permanently shut off by un-
checking the "Print Headers, Footers, & Watermarks " checkbox.

4. From the drop down menu select Footer.
5. Type your message in the text field box and/or select any of the following buttons:

· Job: places the title of the first print job listed in the Print Job window.
· Date: Places today's date.
· Time: Places the current time.
· Page: Places the page Numbers.

6. To change the look and feel of the Footer click the Select Font button. The Font window will open
and from here the Font, Font Style, Size, Effects, Color, and Script can all be changed.  The
Sample window will demonstrate how the changes will appear.

7. The Text justification allows you to choose where the Footer will be placed: right, left, or center.
Place a mark next to the desired position.

8. The Start printing Headers, Footers, and Watermarks on page option allows you to choose which
page the Headers, Footers, and Watermarks will begin.  Note:  This feature allows you to start the
process of printing Headers, Footers, and Watermarks on the mini-page of your choice.  This is
useful for when you have a cover page and you don't want the page number to be printed on that
page.  Please note that the page numbering will start on the page you choose.  For example if you
start on page 3 it will be numbered as 1, page 4 will be 2 and so on.

9. The Stop printing Headers, Footers, and Watermarks on page option allows you to choose which
page the Headers Footers, and Watermarks will end.  Note: The default setting of 0 will end the
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printing of Headers, Footers, and Watermarks on the last page.
10. Click Apply Changes to view any modifications you have made to your headers, footers, or

watermarks.  The changes will appear in the print preview window.  If the changes are acceptable
11. Click OK. Footers will now be placed on your print job.

Note: Footers are not printed on posters.

5.3 Insert A Watermark

Adding a Watermark will add a graphic or text in the diagonal position of each mini-page.  You can
select a separate font, color and size for each type.  We have also provided 4 buttons that will insert
the print job name, date, time and page number into the watermark.

· Job – <job> inserts the name of the first job listed in the Print Job bar
· Date – <date> inserts the current date the job was printed using this format "month dd, yyyy"
· Time – <time> inserts the current time the job was printed using this format "hh:mm AM/PM"
· Page –  <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be
scaled down by a factor of 4 when used on a mini-page that is 4 times smaller than a regular sheet of
paper.  This makes it easy to set up a header, footer, or watermark that can be used for different
booklet types as the text will be automatically sized for each booklet.

Note: Watermark graphics must be in bitmap (.bmp) format.  The graphic colors will not be changed in
any way and will appear the same way it does in your graphic editor.  You may want to lighten up the
graphic before using it as a watermark so the text in front of it does not get washed out.  You can do
this with most graphic editors and word processors.   ClickBook uses a point for point system for sizing
the graphic and will allow you to scale the watermark from 10 times its original size to 1/10 its original
size.  For example, a 600 by 600 pixel graphic would be 1 inch on a mini-page using a 600 dpi (dots
per inch) printer. To make the graphic 2 ½ inches or 2 ½ times bigger enter 2.5 in the edit box below
the Graphic button.
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To place a Watermark on your current print job follow these steps:

1. Click on the Options button  on the toolbar.  This will bring up the Options dialog box.
2. Select the Headers, Footers, and Watermarks tab.
3. In order to print a header a check must be placed next to the Print Headers, Footers,  &

Watermarks field.  Note:  Header, Footers, and Watermarks can be permanently shut off by un-
checking the "Print Headers, Footers, & Watermarks " checkbox.

4. From the drop down menu select Watermark.
5. Now select the desired radio button to include a Text or Graphic Watermark.
6. If Text has been chosen you may now decide what information is to be placed in the Watermark.

Options include placing the following:
· Job: places the title of the first print job listed in the Print Job window.
· Date: Places today's date.
· Time: Places the current time.
· Page: Places the page Numbers.
· Textbox: Type text as you want it to appear.

7. To change the look and feel of the Watermark click the Select Font button. The Font window will
open and from here the Font, Font Style, Size, Effects, Color, and Script can all be changed.  The
sample window will demonstrate how the changes will appear.

8. If Graphic has been chosen you can browse to the location of the image and select it or type the
location of the image in the text field.

9. The Scale watermark graphic times the original size field allows you to make the image larger or
smaller as desired.

10. The Start printing Headers, Footers, and Watermarks on page option allows you to choose which
page the Headers, Footers, and Watermarks will begin.  Note:  This feature allows you to start the



ClickBook Help File36

© 2005 Blue Squirrel

process of printing Headers, Footers, and Watermarks on the mini-page of your choice.  This is
useful for when you have a cover page and you don't want the page number to be printed on that
page.  Please note that the page numbering will start on the page you choose.  For example, if you
start on page 3 it will be numbered as 1, page 4 will be 2 and so on.

11. The Stop printing Headers, Footers, and Watermarks on page option allows you to choose which
page the Headers Footers, and Watermarks will end.  Note: The default setting of 0 will end the
printing of Headers, Footers, and Watermarks on the last page.

12. Click Apply Changes to view any modifications you have made to your headers, footers, or
watermarks.  The changes will appear in the print preview window.  If the changes are acceptable
click OK. A Watermark will now be placed on your print job.

Note: Watermarks are not printed on posters.

5.4 Add Page Numbers

To Add Page Numbers to your ClickBook printouts follow these steps:
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1. Click on the Options button  on the Toolbar, or click Tools on the Menu bar and select
Options.

2. In the Options dialog box click the box next to Print Headers, Footers, & Watermarks.
3. Click the Page button. ClickBook will place the code <#> in the text box.  You can add any

additional text you want to appear before or after the page number.
4. Click OK.  Page numbers will now be placed in the top center position on each mini page for your

print job.

5.5 Add A Border

1. Click on the Options button  on the Toolbar, or click Tools on the Menu bar and select
Options.

2. In the Options dialog box click on the Paper, Borders tab.
3. In the Borders box you can select the type of border you want and the thickness of the lines.
4. Click OK.  A border will now be placed around your print job.
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Note: Borders are not printed on posters.

5.6 Drag And Drop

Once you've created a shortcut on your desktop, or on your Windows task bar to the ClickBook Printer
you can easily select files, and drag and drop them onto the ClickBook Printer icon.  Then ClickBook
will automatically launch the program the file was created in, and print the file to ClickBook .  This is a
great way to speed up the printing process.

To place a ClickBook Printer Shortcut on your desktop  please follow these steps:

1. From the Start Menu, select Settings, then Printers. The Printer dialog box appears with a list of
your printers.

2. Select the ClickBook  Printer, right click, and click on Create Shortcut.
3. Windows will ask you if you want to create the shortcut on your desktop. Click Yes.
4. If you do not receive the Windows message simply activate your desktop, right click, and select

paste shortcut.

Wonderful! Now you can simply drag documents onto the printer icon  to print using
ClickBook .
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To place a ClickBook  Printer Shortcut on your taskbar please follow these steps:  (Please note: in
order to create a shortcut on your Windows Taskbar you must have version I.E. 4.0 or later.)
1. Click on My Computer, and select Printers or from the Start Menu, select Settings, then Printers.

The Printer dialog box appears with a list of your printers.
2. Select the ClickBook Printer.
3. Click and drag the file onto your taskbar.

Congratulations! Now you can easily Drag & Drop files onto your ClickBook Printer on the taskbar to
quickly print booklets.

5.7 Exchange Layouts

When you visit ClickBook's Web page at http://www.bluesquirrel.com/clickbook/, you can submit, and
download new layouts from other users around the globe!

To submit a layout please e-mail the ClickBook layout file (.cbl) as an attachment to:
layouts@clickbook.com.

To download a layout follow these steps:

1. Go to http://www.bluesquirrel.com/clickbook/layouts.asp, and select a layout you wish to download
and click on a file.

2. When the File Download Dialog Box appears, mark the Save File To Disk radio button and select
OK.

3. The Save As dialog box appears. Browse to the folder you would like to store the file in and click

http://www.bluesquirrel.com/clickbook/
http://www.bluesquirrel.com/clickbook/layouts.asp
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OK.
4. The File is saved as a ZIP file, which you will need to open and extract.
5. Extract the file to ClickBook's layouts folder. The default layouts folder is in

C:\Program Files\Blue Squirrel\ClickBook\Layouts\Favorites. You must select a category
(Favorites, All, Booklets, etc.) to store the file in, DO NOT store the file in the layouts folder.

The .cbl file is now stored in your layouts! When you open up ClickBook you will be able to print using
this layout!

5.8 Instant Print

Instant Printing, or 1-step printing automatically starts the printing process without ClickBook program
intervention. For example, if you chose to print a document in Microsoft Word ClickBook would
automatically print the file as a booklet without opening the ClickBook software.

If you have already printed a document once, and print it again using ClickBook it will use the same
layout settings previously, such as, double-sided portrait to print the job. If you elect to print a different
document ClickBook refers to the default layout setting, which is double-sided booklet to print the job.

To enable Instant Printing please follow these steps:

1. Click on the Options button  on the Toolbar, or click Tools on the Menu bar and select
Options.

2. In the Options dialog box click on the Program Settings tab, and mark the Instant Printing check
box.

3. Click OK.  Instant Printing is now enabled!

5.9 Delete A Page

Delete A Page removes pages from a booklet.  This feature comes in handy when you're printing Web
pages to eliminate the last web
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page with only footer information.

To Delete a Page follow these steps.

1. Go to Tools on the menu bar and select Delete a Page…
2. The Delete a Page dialog box appears.
3. Enter the page numbers for the pages you wish to delete in the text box. Refer to the red number

located on the document in the Print Preview window.

OR

1. Right-click on a page in the Print Preview screen and select Delete this page.
2. A confirmation dialog will pop-up asking you to confirm the deletion. Click Yes to continue and

delete the page.

5.10 Print A Table Of Contents

ClickBook will add a Table of Contents to the beginning of your printout that will list the names of the
files located in the Print Jobs menu, and the page number where each file starts printing.

To print a Table of Contents:

1. Click on the Options button  on the toolbar.  This will bring up the Options dialog box.
2. Choose the Print Settings tab and place a check in the box entitled Print a Table of Contents

Page.
3. Click OK, and ClickBook will add a Table of Contents to the printout.
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5.11 Adjustable Mini-pages

Use the Adjustable Mini-Page feature to enlarge fonts and graphics and decrease the margins. You will
input how far left, right, up and down you want to reduce the mini-page margins to enlarge text and
graphics.

To use this feature proceed with the following steps:

1. Click on the Options button  on the toolbar.  This will bring up the Options dialog box.
2. Choose the Print Settings tab and place a check in the box entitled Enable Adjustable Mini-pages.

3. Click OK, and ClickBook will enable Adjust Mini-page button  in the
Modify Layout dialog box.

4. From the Menu bar open Layouts and select Modify Layout.  The Modify Layout dialog appears.
5. Choose the Adjust Mini-page button under Margins. The Adjust Mini-Page Dialog appears.
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6. Adjust the Margins to your liking.  For example, to print an enlarged booklet with centered text
you'll reduce the position by .5 inch up, and to the left. The you'll need to compensate for the
bottom and right margins by reducing them 1 full inch.

2. Mark the check box next to Apply position 1 adjustments to all mini-pages if you want the
adjustments to appear on all pages of your booklet.

3. Press OK. Review the changes in the Print Preview, and repeat steps 1 through 6 to further adjust.
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5.12 PDF Settings

AutoName - If you check this option, you will not be prompted to name the PDF file.  The name will
be derived from the name of the document that you printed first.

Don't prompt when writing over a file with the same name - Check this option when you would like to
replace previously created PDF files with new PDF files.  This option usually goes with AutoName.
Then when you create a new PDF with the same name, the old one will be overwritten.

Optimize the PDF file for the web - This option creates a PDF file that will load into a browser in
stages.  The first page will be available to read while the other pages are still loading.

Change the colors to grayscale in the PDF file - This converts color documents to greyscale
documents.  Sometimes it is easier to print a greyscale document on black and white laser printers.

Open PDF file after creation - This launches the PDF viewer so you can see the created document
after printing.

6 Layouts
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6.1 Types Of Layouts

This topic will be easy to understand if you read it while looking at ClickBook's Print Preview screen.
Select various layouts in turn, and compare each one.

What is a Layout?
A layout is a blueprint for a particular booklet, which is defined by a group of detailed settings that tell
ClickBook how to arrange the mini-pages on a sheet of paper.  Some of the essential details are
whether the paper orientation is portrait or landscape, how many mini-pages are printed across and
down on one sheet, whether to print single or double-sided, margin sizes, and added space for binding.

Booklet Styles
Each layout also has a certain booklet style.  This relates to how you intend to assemble and bind the
booklet, and tells ClickBook the order to print the mini-pages so they will end up in the right order in
your finished booklet.  There are six booklet styles: Cut book, Folded book, French fold, Planner
pages, Tiled, and Tri-fold.  You can determine a layout's booklet style by its name, the corresponding
picture, and by looking at the Booklet Style in the Modify Layouts tab.

 Cut book Layouts are for methods of binding that require cutting between facing pages.
Most of the cut book layouts shipped with ClickBook are designed for paper that's pre-perforated for
a custom appointment-book page.

Folded book Layouts are designed for folding between facing pages, and stapling.
Examples include the "Address book (folded)", "Wallet book (folded)", and "Side-by-side (folded)"
layouts.

 French fold layouts are for making greeting cards from standard paper by folding the
printed sheet in fourths.   The French fold style expects exactly four pages per sheet.

 Planner page Layouts are designed for day planner paper that has holes on the left and
right hand sides.

 Posters are designed to expand one page onto multiple pages to make it larger.  It requires
some trimming and taping, but you can make some impressive posters.

 Tiled layouts are designed for multiple pages on a sheet but not cutting the sheet.  The
sheets that come out of the printer are the final sheets.  There are two sequences in which the mini-
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pages can be printed in a tiled layout.  These are controlled by the Binding Orientation options in the
Modify Layouts dialog.

· Row-wise means page 2 prints to the right of page 1.  For row-wise order, select the Standard
binding orientation.

· Column-wise means pages 2 prints below of page 1.  For column-wise order, select the Flip
binding orientation.

Tri-fold Layouts are for printing single-sheet brochures or leaflets which are folded twice,
making three panels (mini-pages) on each side of the paper.   The tri-fold style expects exactly six
pages per brochure, since this style of brochure is a single sheet of paper, folded.  Tri-fold pagination
places pages 5, 6, and 1 on one side, and pages 2, 3, and 4 on the other side.  The front panel is
thus page 1, and the reader opens up the brochure to see pages 2, 3, and 4 inside, and then turns
the sheet over to read pages 5 and 6.

6.2 Selecting A Layout

Answering the following series of questions will help you decide which layout you want.

· Is your document oriented as portrait or landscape?  You should choose a layout that orients the
mini-pages in the same way.  Look at the picture for each layout to determine its mini-page
orientation.  (ClickBook will warn you if you choose a layout that doesn't match.

· What sort of booklet do you want to print?
· How large do you want your finished mini-pages to be?  Mini-pages determine how many pages

you want to include on a single sheet of paper, and how to fit them on the size of paper you're
using.  For examples look through the tiled or booklet layouts.  To choose a layout with an
appropriate number of mini-pages, look at the print preview picture.

· What size do you want your fonts and graphics to appear?  Small booklets usually require that you
enlarge the fonts and graphics, unless you choose to use No Scaling.  If you choose No Scaling
enlargement must be done in your application program and then print the document to ClickBook
again.  If you want to enlarge the fonts in ClickBook refer to adjustable Mini-pages.

To Select a Layout:
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1. Print your document to ClickBook.  For step-by-step instructions refer to
Printing Your First Booklet.

2. In the Print Preview screen Browse through the Category drop down menu to quickly find layouts
that match your document type.  For example, if you're printing a side-by-side folded booklet
choose the Books category.  Or if you're printing your contact list to insert in your Day Planner,
choose Personal Organizers, or Franklin Covey Paper.

3. Use the Layout drop down menu to browse through the available Layouts, and select one that
matches your document.

4. To see the settings for a particular layout, select Layouts on the Menu bar and click on Modify
Layouts.

6.3 Creating Or Modifying A Layout

To create a custom layout you will modify, rename, and save an existing one by following these steps:

1. Print your document to ClickBook.  For step-by-step instructions refer to
Printing Your First Booklet.

2. From the menu bar open layouts and select either Layout Wizard or Modify Layout.  Please refer
to either topic for more details.

3. Choose a layout that is similar to what you want.
4. Change any settings to create just the layout you want.
5. When you are finished making adjustments click the Save As button and save the new layout with

a different name.

To modify an existing Layout proceed with the following steps:

1. Print your document to ClickBook.  For step-by-step instructions refer to
Printing Your First Booklet.

2. From the menu bar open layouts and select either Layout Wizard or Modify Layout.  Lets choose
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Modify Layout for this particular exercise.
3. The Modify Layout dialog appears.  Choose a Category and Layout from the drop down menus

that are similar to what you want.
4. Make desired changes by adjusting margins, scaling, mini-page margins, how many mini-pages

you would like to appear on a single sheet of paper and so forth.
5. Click Save As to save your changes to a new layout or Done to replace the old one.   Click

Abandon Changes to undo all of the changes you haven't yet saved.  The Layout will revert back
to its original settings.

6. Examine your changed Layout in the Print Preview picture to see how your document is affected.
If you are satisfied with how the booklet looks, click Print.  If you are not satisfied repeat steps 2
through 4 to further adjust the layout.

Note: Blue Squirrel recommends making a backup of your Layouts before altering them.  You can do
this by copying the Layouts folder to a new name or to a backup disk. The default directory is
C:\Program Files\Blue Squirrel\ClickBook\Layouts.  Then, if you ever need to revert to the default
Layouts, just restore the original files.

7 Printing And Printers
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7.1 Printing Multiple Copies Sequentially

To print multiple copies of the same print job:

1. As usual, print from your application program to a ClickBook printer.
2. When ClickBook pops up, set the Num of copies option.
3. Click Print.  ClickBook prints the first sides of all copies, with a single instruction sheet.
4. After the first sides of all copies have finished printing, put the whole printout stack back in the

printer.
5. Click the Print Second Side button.
6. After the second sides of all copies have finished printing, separate the copies.
7. Cut, assemble, and bind each booklet individually.

Note: If you want to print multiple identical booklets, follow the instructions above.  Setting multiple
copies within your application program will not work correctly.

7.2 Previewing The Printout

The Print Preview lets you see how your document will look when printed with the selected layout.  It is
not accurate in every detail, and your actual printout will look better than the preview.  But the Print
Preview enables you to see most features of the printout, such as:

· How mini-pages are positioned.
· The relative sizes of margins and data.
· How many sheets will print.
· How many blank mini-pages will be printed at the end.

Zoom in on a mini-page by clicking on the mini-page or right-click and choose the zoom level up to
800%.  Repeated clicks will zoom in closer and closer until 800% is reached and then another click will
take you to the full sheet view.

You can also zoom with the scroll wheel on your mouse.  Position the cursor over the preview window
and scroll the wheel to zoom in and out.

Note:
· Use the bar beneath the picture to navigate to different sheets of the booklet:

· To go to the first or last sheet, click the arrow button at the left end or right end of the bar.
· To go to the next previous sheet, drag the slider button left or right.  When the desired sheet

number is shown, release the mouse button.
· To go to the next or previous sheet click the bar on the left or right side of the slider, depending
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upon which way you want to go.
· Use the front and back buttons to see the other side of the currently displayed sheet.
· Use the Sheet selection to select a sample sheet to print for 100% accuracy.

7.3 Reinserting The Print Out Stack Before Printing The Second Side

The critical step of double-sided printing is correctly reinserting the first-side print out correctly into the
printer so the second side can be printed.  Each detail of this process is important:

· When you are certain that all of the sheets from the first-side printout are done, remove the
printout stack from the printer without rearranging the pages.  Make certain that if any other print
jobs were sent to this printer, that you are holding only your intended printout.  If you're on a
network and a printer prints an extra sheet (blank, or with network user id, for example) between
printouts, throw out that sheet.

· Turn the stack over if necessary to find the instruction sheet.  Read the instruction sheet without
lifting it off the stack.

· Reinsert the stack with the instruction sheet still on it.
· If your printer puts out an extraneous sheet before each print job ( e.g. printout separator sheets

on network printer), place a blank sheet on top after reinserting the stack.  If the printer went
offline when you reinserted the stack, put it back online.

7.4 Return To ClickBook After Printing

With the Return to ClickBook after printing option is turned on, ClickBook will remain open after printing
is complete allowing you to:

· Reprint a sheet or a range of sheets.
· Save the booklet just printed as a .cb file.
· Print the document as a different layout.
· Modify the layout and print the document again.

You can turn this feature on temporarily for the current print job, or permanently for all future print jobs.

Follow these steps to enable this feature permanently:
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1. From the Toolbar choose the Options button .
2. The Options dialog box appears, select the Program Settings Tab.
3. Mark the checkbox next to Return to ClickBook after printing.
4. Press OK.

Follow these steps to enable this feature temporarily:

1. Print file(s) to ClickBook.
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2. Click the Print button to send the Print Jobs to the printer.
3. While the booklet is printing ClickBook will quickly display a status screen, mark the check box to

Return to ClickBook after printing. (Be aware: this pops up and closes fast.)
4. ClickBook will re-open.  This feature will remain on for the current print job.

7.5 Print A Range Of Sheets

Sometimes you want to print only a part of a booklet, for reasons such as:

· Before printing the whole booklet, you want to print a sample sheet to see how it looks.
· A sheet of paper jammed in your printer or came out creased.
· After printing, you needed to make a small change that affected just a few pages of your

document and did not change the pagination.
· Sheet #3 fell on the floor and the dog ate it…

Whatever the reason, you can reprint just the affected sheets, rather than the entire print job.  Here's
how:

1. Click the Sheet Selection button.
2. Specify the range of sheets to be printed by setting First Sheet and Last Sheet.  You must specify

the first and last sheet by number.  Note: You can print one sheet or a continuous range, but not
discontinuous sheets (like 1 and 4).

3. Choose the desired option for printing fronts and/or backs of the sheets.  Also choose whether or
not to print the instruction sheet.

4. Click Print to begin printing.

Note: Refer to Previewing the Printout to learn how to navigate different parts of the booklet in the Print
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Preview Screen.  Refer to Return to ClickBook After Printing to prepare for the possibility of having to
reprint a booklet before it finishes printing.

8 Helpful Hints
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8.1 Setting Margins And Binding Space

Margins
Paper margins allow you to change the margins for a sheet of paper, and Mini-Page margins allow you
to change the mini-page margins for the current Layout.

Important:
· ClickBook's margins are in addition to the margins set in your application program.
· Unlike the application program's margins, which gets scaled down along with the contents of your

document, ClickBook's margins print at the exact size specified.

To change either margins follow these steps:

1. From the Menu bar select Layouts and click on Modify layouts.
2. Under the Margin section alter the settings to your liking by using up and down arrows on the

number boxes.  To make a big increase or decrease, hold the mouse button down  until the
desired value is reached.

3. View the results by watching the Layout picture, which redraws automatically to show the margin
changes.  The margins, including the Binding margin are shown in blue.

4. When you are finished, press Done.

Note: Usually you should set your application program's page margins or ClickBook's Top/Bottom and
Left/Right Mini-page Margins.  If you choose to set ClickBook's we recommend that you first print a
part of your booklet and measure the exact of margin you want to add.  Then print the entire document
with the Mini-page margins set correctly.

Note: Set the Paper Margins to match the cut-away or pre-perforated tear-off areas around the edges
of some custom papers.

Binding
The Binding margin is extra space only on the side where the book will be bound.  You can adjust the
following:

· Printer Paper Size - Select the size of paper you want to use.
· Binding Edge - Choose how you want the binding edge.
· Print Sides - Select to print on one side or both sides of paper.

Proceed with the following steps to change Binding.
1. From the Menu bar select Layouts and click on Modify layouts.
2. Under the Binding section alter the settings to your liking.
3. When you are finished, press Done.

8.2 Printing Sub-booklets To Bind Together

Rather than folding a whole booklet together, you may wish to print and fold sub-booklets separately,
and then bind them together.
Reasons for using sub-booklets include:

· To avoid shingling or margin creep that otherwise occurs with thick folded booklets.
· To meet the needs of special binding methods.
· To separate individual documents from a mail-merge print stream.

To enable ClickBook's Sub-booklet feature follow these steps:

1. From the Menu bar select Layouts and click on Modify layouts.
2. The Modify Layout dialog box appears. Under the Sub-booklet section mark the checkbox next to

Sub-booklets.
3. Use the up and down arrows next to Pages-per to set the amount of pages each sub-booklet will
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contain.
4. When you are finished press Done.

8.3 Repeat

The effect of Repeat depends on the current Layout.  Repeat can be used to print more copies when
there aren't enough mini-pages to fill the sheet.   Repeat can also be used, alternatively, to avoid the
step of assembling multiple booklets.  ClickBook contains two Layouts with Repeat turned on, they are
the Business card layouts and Greeting card (heavy stock repeat) layouts.

To activate Repeat proceed as follows:

1. From the Menu bar select Layouts and click on Modify layouts.
2. The Modify Layout dialog box appears. Under the Sub-booklet section mark the checkbox next to

Repeat.
3. When you are finished press Done.

9 Glossary

· Aspect Ratio - The ratio of width to height.  If the aspect ratio changes then photographs can
appear stretched or squeezed.

· Banner - A Poster that is significantly wider than it is tall.
Constructed by taping multiple pages together, it usually announces happy events like birthdays,
homecomings, and graduations.

· Binding Edge - A standard binding edge is for right/left.  A flip binding edge is for folding top/bottom.
· Crop - Cropping chops off portions of a document.
· Duplex - Printing on both sides of the paper.  Many printers include a duplexer that allows the printer

to print on both sides of the paper without human intervention.  ClickBook supports printers with
duplexers.

· Header - Text that will be printed at the top of every mini-page.  It may include page numbers, job
name, date, etc.

· Footer - Text that will be printed at the bottom of every mini-page.  It may include page numbers, job
name, date, etc.

· Landscape - A paper orientation where the words on the page are going across the long edge of the
paper.  See Portrait.

· Layout - A specific configuration of ClickBook that turns a print out in to a poster, booklet, card,
brochure, etc.

· Mini-Pages - The area on a piece of paper that the source document pages will be placed.
Example: One piece of paper would have 4 mini-pages for a folded booklet.  Two mini-pages on
each side of the piece of paper.

· One-to-One - A Scaling option that keeps the shape.  This scaling option is better for photos.
· Overlap - When printing Banners or Posters, some extra is printed on each page to allow easy

alignment of the pages when assembling the poster or banner.
· Portrait - A paper orientation where the words on the page are going across the short edge of the

paper.  See Landscape.
· Poster - A large format print out which is constructed by taping pages together.
· Poster Wizard - A quick easy way to create a custom poster.  For more fine control, use Modify

Layout.
· Sample Document - A document that works with a set of layouts.  The many samples included with

ClickBook show how the document works with ClickBook to create a print out.
· Scaling - Stretching or shrinking a document to fit an area on a piece of paper.  One-to-one scaling

will keep the aspect ratio.
· Stretch-to-Fit - Stretches the source document to fit the new area.  If the area is not the same

shape, the document may need to be stretched more in one direction.  This is usually fine for text,
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but leads to photos that may look stretched or squeezed.
· Sub-booklets - Breaking a full booklet print job into smaller booklets that can be individually folded,

stacked and bound.
· VIP Key - A key that removes the trial stamps and fully activates the software.
· Watermark - A graphic that is printed on every mini-page.  This can be used for document

authenticity, or to print a company logo.

10 Support

Technical Support

If you are having difficulties using ClickBook, please check the following:

The problem may be with the printer.  See whether the problem still occurs when you (A) print without
ClickBook, or (B) print on a different printer.  If the problem still occurs in case A, or goes away in case
B, the problem is with your printer or its driver.  The first possible solution is to get a newer printer
driver.  If no newer driver is available, or using the latest one does not solve the problem, contact the
manufacturer or vendor of your printer.

Frequently, problems observed in applications actually are based in the operating system.  Does your
problem occur in other applications as well?  Do any other symptoms suggest that the problem may be
in Windows?  If so, you need Windows technical support.

Read the accompanying ReadMe.rtf file for any late breaking information about ClickBook, and using
ClickBook with specific software or hardware. You can access the ReadMe file by going to your
Windows Start Menu. Then Select Programs, Blue Squirrel, and ClickBook ReadMe. Please note this
is the default location, your ReadMe file may be stored elsewhere.

Visit Our Web Site
Blue Squirrel offers free online technical support to customers that purchase ClickBook. Customers
wishing to speak with a Blue Squirrel representative can purchase a Technical Support contract for
$19.95/month by calling 800-403-0925. Technical Support contract owners can speak with a Blue
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Squirrel representative Monday through Friday from 9:00 am to 5:00 pm Mountain Standard time.

If you cannot find the information you need in any of the preceding sources, contact us at our Web site.
Please refer to ClickBook's support and FAQs for frequently asked questions.
http://www.bluesquirrel.com/support/

Contact Us
If you would like to speak with a Blue Squirrel representative regarding a non-technical question please
call Customer Service at:

Customer Service
Toll Free: 800-403-0925
Telephone: 801-352-1551
Fax: 801-912-6032
E-mail: sales@bluesquirrel.com

Note: Hours are: 8:00 a.m. to 5:00 p.m. Mountain Standard Time.

Mailing address
Blue Squirrel
686 E. 8400 South
Sandy, UT  84070

11 License

BLUE SQUIRREL END USER LICENSE AGREEMENT
(REDISTRIBUTION NOT PERMITTED)
BY INSTALLING THE BLUE SQUIRREL SOFTWARE, YOU ARE CONSENTING TO BE BOUND
BY THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS
AGREEMENT, DO NOT INSTALL THE BLUE SQUIRREL SOFTWARE, OR IF YOU HAVE
ALREADY INSTALLED IT,
UNINSTALL IT IMMEDIATELY.

GRANT. Subject to payment of applicable license fees, Blue Squirrel grants you a non-exclusive license to use the Software
and accompanying documentation ("Documentation") in the manner described below under "Scope of Grant."
SCOPE OF GRANT.

You may:
use the Software on any single computer;
use the Software on a network, provided that each person accessing the Software through the network must have a copy
licensed to that person;
use the Software on a second computer so long as only one copy is used at a time;
copy the Software for archival purposes, provided any copy must contain all of the original Software's proprietary
notices;
or if you have purchased licenses for a 10 pack or a 50 pack, make up to 10 or 50 copies, respectively, of the Software
(but not the Documentation), provided any copy must contain all of the original Software's proprietary notices. The
number of copies is the total number of copies that may be made for all platforms. Additional copies of Documentation
may be purchased.

You may not:
permit other individuals to use the Software except under the terms listed above;
permit concurrent use of the Software;
modify, translate, reverse engineer, de-compile, disassemble (except to the extent applicable laws specifically prohibit
such restriction), or create derivative works based on the Software;
copy the Software o ther than as specified above;
rent, lease, grant a security interest in, or otherwise transfer rights to the Software; or

http://www.bluesquirrel.com/support/
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remove any proprietary notices or labels on the software.

LIMITED WARRANTY. Blue Squirrel warrants that for a period of thirty (30) d ays from the date of acquisition, the
Software, if operated as directed, will substantially achieve the functionality described in the Documentation. Blue Squirrel
does not warrant, however, that your use of the Software will be uninterrupted or that the operation of the Software will be
error-free or secure. In addition, you must determine that the Software sufficiently meets your requirements. Blue Squirrel
also warrants that the media containing the Software, if provided by Blue Squirrel, is free from defects in material and
workmanship and will so remain for thirty (30) days from the date you acquired the Software. Blue Squirrel's sole liability for
any breach of this warranty shall be, in Blue Squirrel's sole discretion; (i) to replace your defective media; or (ii) to advise
you how to achieve substantially the same functionality with the Software as described in the Documentation through a
procedure different from that set forth in the Documentation; or (iii) if the above remedies are impracticable, to refund the
license fee you paid for the Software. Repaired corrected, or replaced Software and Documentation shall be covered by this
limited warranty for the period remaining under the warranty that covered the original Software, or if longer, for thirty (30)
days after the date (a) of shipment to you of the repaired or replaced Software, or (b) Blue Squirrel advised you how to
operate the Software so as to achieve the functionality described in the Documentation. Only if you inform Blue Squirrel of
your p roblem with the Software during the applicable warranty period and provide evidence of the date you purchased a
license to the Software will Blue Squirrel be obligated to honor this warranty. Blue Squirrel will use reasonable commercial
efforts to repair, replace, advise, or refund pursuant to the foregoing warranty within 30 days of being so notified.

THIS IS A LIMITED WARRANTY AND IT IS THE ONLY WARRANTY MADE BY BLUE SQUIRREL. BLUE
SQUIRREL MAKES NO OTHER EXPRESS WARRANTY AND NO WARRANTY OF NONINFRINGEMENT OF THIRD

PARTIES, RIGHTS. THE DURATION OF IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION,
WARRANTIES OF MERCHANT ABILITY AND OF FITNESS FOR A PARTICULAR PURPOSE, IS LIMITED TO THE

ABOVE LIMITED WARRANTY PERIOD; SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW
LONG AN IMPLIED WARRANTY LASTS, SO LIMITATIONS MAY NOT APPLY TO YOU. NO BLUE SQUIRREL

DEALER, AGENT, OR EMPLOYEE IS AUTHORIZED TO MAKE ANY MODIFICATIONS, EXTENSIONS, OR
ADDITIONS TO

THIS WARRANTY.
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